
Nudgis - Guide d'intégration LMS

Nudgis - Guide d'intégration LMS

Cette documentation décrit les manières d’intégrer du contenu généré par UbiCast dans un
LMS, aussi bien de manière générique que par le biais de notre plugin open source (Moodle
uniquement). Notez que Moodle sera utilisé comme exemple dans cette documentation, pour
des questions spécifiques veuillez vous référer à la documentation de votre LMS.

This documentation is also available in english.
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​Prérequis
Afin que l'intégration de médias et de chaînes puisse fonctionner dans votre LMS (Learning
Management System), il faut que le LMS et Nudgis soient dans le même domaine.
Exemple correct :
Moodle : mon-moodle.example.com
Nudgis : mon-Nudgis.example.com
Exemple incorrect :
Moodle : mon-moodle.example.com
Nudgis : mon.Nudgis.com

Pour la version 1.3 de LTI, il faut que les serveurs Nudgis et ceux du LMS puissent
communiquer entre eux avec leurs URLS HTTPS.

​
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1. LTI et Nudgis: vue d’ensemble

​1.1.​ A propos de LTI

LTI est un protocole qui permet aux utilisateurs de LMS d’intégrer du contenu fourni par un
outil web tiers simplement et de manière sécurisée.

LTI fonctionne avec des liens dédiés pour accéder aux contenus. Chaque contenu intégrable
par LTI est appelé "outil" dans la nomenclature de LTI.

Nudgis gère les versions suivantes de LTI :
- LTI 1.0 et LTI 1.1 : Le protocole d'authentification est basé sur OAuth1 et toute la

communication entre le LMS et Nudgis transite par le navigateur de l'utilisateur. Ces
versions sont dépréciées.

- LTI 1.3 : Le protocole d'authentification est basé sur OAuth2 et la communication entre
le LMS et Nudgis se fait via le navigateur de l'utilisateur mais aussi entre les serveurs
directement (ce qui nécessite que les serveurs du LMS et de Nudgis puissent
communiquer dans les 2 sens en HTTPS). Cette version est celle recommandée.

NB: Il n'est pas possible d'utiliser LTI 1.0/1.1 et LTI 1.3 en même temps avec Nudgis car les
attributs LTI ne sont pas les mêmes entre les versions.

Les URLs LTI ressemblent à celui-ci :
https://votre.nudgis/lti/v125395dfecaao1pn1ue/

La partie la plus intéressante de LTI est qu’il supporte la notion de rôles utilisateur ; cela veut
dire que le fournisseur d’outil LTI connaît les droits que l’utilisateur devrait obtenir lorsqu’il
accède à un contenu.

Pour résumer, la sécurité est basée sur le fait que si l’utilisateur peut accéder au contenu dans
le LMS (ex. : un étudiant inscrit à la classe “A”), alors n’importe quel contenu situé dans la
classe “A” lui sera accessible.

contact@ubicast.eu
https://docs.ubicast.eu/
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Une liste non exhaustive des fournisseurs et clients LTI est disponible ici :
http://developers.imsglobal.org/catalog.html

Comment le modèle de sécurité fonctionne :

contact@ubicast.eu
https://docs.ubicast.eu/
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​1.2.​ Paramétrage initial de LTI

Nudgis inclut une intégration de LTI depuis la version 4.6.

La version 1.3 du protocole LTI est supportée depuis la version 11.2.0 de Nudgis. Depuis que
LTI 1.3 est supportée, les versions précédentes de LTI sont dépréciées.

Pour la paramétrer, voici les étapes à suivre (une description de chacune des étapes est
disponible ci-dessous) :

1) Activer LTI dans Nudgis.
2) Déclarer le LMS (soit avec l'inscription dynamique ou en paramétrant manuellement
les informations du LMS).
3) Définir les permissions des rôles.

1) Activer LTI dans Nudgis

Pour accéder aux paramètres LTI, rendez-vous dans le menu d’administration :

contact@ubicast.eu
https://docs.ubicast.eu/
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Allez ensuite dans les paramètres des services d'authentification :

Activez le service LTI :

contact@ubicast.eu
https://docs.ubicast.eu/
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2) Déclarer le LMS

Avec le lien d'inscription dynamique :

Utilisez cette méthode si votre LMS gère la fonctionnalité nommée "Dynamic registration" de
LTI.
Pour utiliser cette fonctionnalité, il vous suffit de copier coller le lien dans votre LMS pour que
la configuration soit faite dans le LMS et dans Nudgis.
Le lien est disponible dans les paramètres LTI de Nudgis :

contact@ubicast.eu
https://docs.ubicast.eu/
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Ou en déclarant manuellement les informations du LMS :

Dans le cas où votre LMS ne gère pas la fonctionnalité d'inscription dynamique ("Dynamic
registration"), vous devrez renseigner manuellement les informations de votre LMS dans
Nudgis.

N'oubliez pas de cliquer sur "Sauvegarder" une fois que toutes les informations sont remplies.

contact@ubicast.eu
https://docs.ubicast.eu/

9

mailto:contact@ubicast.eu
https://docs.ubicast.eu/


Nudgis - Guide d'intégration LMS

Correspondances des champs

En fonction des données de votre LMS, il est possible que vous ayez à modifier le tableau de
correspondance des champs des utilisateurs. Pour savoir ce que votre LMS envoie comme
champ, vous pouvez utiliser la page de test (voir la section 1.3. pour plus d'informations sur la
page de test).

Pour la plupart des LMS et quand LTI 1.3 est utilisé, les valeurs par défaut pour la
correspondance des champs sont correctes.

Les valeurs par défaut sont :
● Nom d'utilisateur : email
● Email : email
● Prénom : given_name
● Nom : family_name

contact@ubicast.eu
https://docs.ubicast.eu/
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3) Définir les permissions des rôles

Les permissions de rôles peuvent être définies finement (notez que deux rôles par défaut sont
fournis : Étudiant et Instructeur).

Pour aider à comprendre quels rôles le LMS accorde et débugger les permissions, vous devriez
ajouter le lien “Page de test” dans le LMS, puis cliquer dessus ; cela vous permettra
d’inspecter les noms de rôles définis par le LMS.

Important : Dans les versions 11.1.1 et précédentes, les rôles transmis par le LMS étaient
automatiquement préfixés par :

● "urn:lti:role:ims/lis/" pour les rôles qui ne commencent pas par "urn:lti:" et qui ne
contiennent pas "ims/lis/".

● "urn:lti:" pour les rôles qui ne commencent pas par "urn:lti:" et qui contiennent
"ims/lis/".

contact@ubicast.eu
https://docs.ubicast.eu/
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1.3. Page de test LTI

La page de test LTI permet de s'assurer que la configuration de LTI est fonctionnelle et permet
également de voir quelles sont les données envoyées par le LMS.

La page de test doit être activée dans les paramètres de LTI de Nudgis :

Le lien de la page de test est disponible dans les paramètres LTI de Nudgis :

Ajoutez l’URL de la page de test comme un lien LTI dans le LMS, puis cliquez dessus. Cela
affichera les valeurs transmises par LTI pour le débuggage.

contact@ubicast.eu
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Note : Depuis la version 8.4.0, il est possible d’envoyer la progression de lecture en tant que
note au LMS, activez simplement l’option dans la page de paramétrage LTI et dans votre LMS.

​1.4.​ Exemple de fonctionnement

1. L’enregistrement est déclenché sur une Miris Box UbiCast avec l’email de l’orateur dans
les métadonnées (speaker_email).

2. Lorsque la capture s’arrête, l’enregistrement est envoyé automatiquement sur le
Nudgis.

3. A la réception, lorsque le média est prêt, Nudgis envoie un email au professeur
contenant le lien LTI ainsi que (potentiellement) des instructions.

4. Après l’intégration du lien LTI dans le LMS, lorsque l’enseignant clique sur le lien il est
automatiquement reconnu en tant qu’éditeur et modérateur.

contact@ubicast.eu
https://docs.ubicast.eu/
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​1.5.​ Gestionnaire demédias

Nudgis fournit une page dédiée à la fonctionnalité Deep Linking de LTI. Cette page est
nommée "gestionnaire de médias".

Cette page permet d'accéder aux fonctionnalités suivantes :
- Création de médias par l'envoi de fichiers.
- Création de médias par l'enregistrement du bureau de l'utilisateur.
- Sélection de médias existants.
- Accès à l'interface de gestion des activités (questionnaires et sondages).
- Accès à la modération des commentaires de tous les médias que l'utilisateur peut

modérer.

La page est disponible à l'URL suivante : "/manager/". Par défaut, la page ne présente que les
médias dont l'utilisateur est l'intervenant. Il est possible d'ajouter l'argument "?all" à l'URL
afin que tous les médias accessibles par l'utilisateur soient présentés.

Documentation sur le Deep Linking :
https://www.imsglobal.org/spec/lti-dl/latest/https://www.imsglobal.org/specs/lticiv1p0
https://canvas.instructure.com/doc/api/file.content_item.html

contact@ubicast.eu
https://docs.ubicast.eu/
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​2. Exemples de paramétrage de

LMS
2.1.Moodle

2.1.1. Intégration LTI générique

Note: L’intégration LTI 1.3 ne permet pas encore de gérer les rendus de devoirs qui nécessitent
encore l’utilisation de nos plugins. Certains plugins permettent de pallier cette fonctionnalité
manquante dans Moodle.
Note 2: Moodle ne permet pas d'utiliser de certificats auto-signés, veuillez vous assurer de la
validité du certificat de Nudgis vu par Moodle.

​2.1.1.1.​ Configuration deMoodle

Tout d’abord vous devez déclarer Nudgis dans Moodle en tant que fournisseur LTI en utilisant
l’interface d’administration.

https://votre_serveur_moodle/admin/search.php#linkmodules

Cliquez sur "Manage tools" dans les modules des activités :

contact@ubicast.eu
https://docs.ubicast.eu/
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Mettez le lien d'inscription dynamique dans le champ:

Rappel : LTI doit être activé dans Nudgis et vous devez utiliser le lien d'inscription dynamique
généré dans Nudgis.
Cliquez sur "Add LTI Advantage".

Moodle va ouvrir le lien dans une fenêtre et si tout se passe bien, un message de succès va
apparaître.

contact@ubicast.eu
https://docs.ubicast.eu/
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Cliquez sur le bouton "Fermer".

Nudgis est désormais déclaré dans Moodle, cliquez sur le bouton "Activate" pour rendre
disponible Nudgis dans Moodle :

Si nécessaire, vous pouvez modifier le titre de l'outil dans ses paramètres.

2.1.1.2.​ Ajouter du contenu
Allez dans un cours et activez le mode d'édition dans le coin en haut à droite de la page :

contact@ubicast.eu
https://docs.ubicast.eu/
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Ajoutez ensuite une activité au cours :

Choisissez "outil externe" :

Sélectionnez l'outil préconfiguré et cliquez sur "sélectionner du contenu" :

Choisissez un contenu dans la fenêtre qui apparaît, le lien du contenu sera rempli dans le
champ "URL de l'outil" :

contact@ubicast.eu
https://docs.ubicast.eu/
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Avant de sauvegarder, assurez vous que votre navigateur n'a pas rempli automatiquement les
champs "Clé du consommateur" et "Secret partagé" avec votre identifiant/mot de la passe.
Ces deux champs doivent être vides.
Pour finir, cliquez sur "sauvegarder et afficher".

Le média est ensuite directement consultable dans Moodle (et administrable si le rôle le
permet. L’accès à l’édition et aux statistiques est indiqué ci-dessous par le cercle rouge en
haut à droite du lecteur) :

contact@ubicast.eu
https://docs.ubicast.eu/
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2.1.1.3.​ Choisir le rôle envoyé àNudgis (outil externe)
Quand Nudgis est intégré dans un cours Moodle comme un "outil externe" (la page de test

et le manager Nudgis sont des outils externes) pour choisir le rôle envoyé, il faut aller dans

: Administration du site > Utilisateurs > Permissions > Définition des rôles.

Il faut modifier le rôle souhaité et, dans le paragraphe “Capacité”, travailler sur les lignes

suivantes:

- Si “Être formateur lorsqu'un outil externe est lancé“ et “Devenir un administrateur

lorsque l'outil est lancé “ sont en “Non défini”, il s’agit du rôle Etudiant qui sera envoyé

à Nudgis.

- Si “Être formateur lorsqu'un outil externe est lancé“ est autorisé, il s’agit du rôle

Enseignant qui sera envoyé à Nudgis. Il prendra le dessus par rapport au rôle Etudiant.

- Si “Devenir un administrateur lorsque l'outil est lancé“ est autorisé, il s’agit du rôle

Admin qui sera envoyé à Nudgis. Il prendra le dessus par rapport au rôle Enseignant et

Etudiant.

2.1.​2. PluginsMoodle

Veuillez noter que ces plugins se basent sur LTI 1.1 et vont être dépréciés en faveur de
l’intégration LTI 1.3 lorsqu’elle permettra de gérer les rendus de devoirs.

Une démonstration est disponible à cette adresse :
https://help.ubicast.tv/permalink/v125cf31d9a43cbjecrn/

Vous pouvez trouver UbiCast Nudgis Moodle dans le répertoire des plugins de Moodle :
https://moodle.org/plugins/?q=ubicast

​2.1.2.1.​ Configuration du plugin
UbiCast fournit un plugin Moodle qui, une fois déployé sur votre serveur Moodle, ajoute un
nouveau type d'activité. Le plugin est disponible à cette adresse :

contact@ubicast.eu
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https://moodle.org/plugins/mod_ubicast

Ensuite, il faudra vous fournir de vos identifiants LTI (la clé et le secret) pour les ajouter dans
les paramètres du connecteur Ubicast Nudgis (Administration du site > Plugins > Modules
d'activité > Connecteur UbiCast Nudgis)

https://moodle/admin/settings.php?section=modsettingubicast

Il faudra également entrer vos identifiants LTI dans le connecteur externe LTI.

A noter qu’il existe deux autres plugins (ils nécessitent le plugin principal pour fonctionner.)
que nous décrirons plus tard à savoir :
- Ajout d’un bouton Nudgis dans l’éditeur :
https://moodle.org/plugins/atto_ubicast
- Ajout d’un bloc chaîne personnalisée:
https://moodle.org/plugins/block_ubicast

Téléchargez ZIP depuis le répertoire Moodle puis ajoutez-le via le menu Administration du site
> Plugins > Installer les plugins > Installer le plugin depuis le fichier ZIP.

Notez bien que la remontée de score (note) LTI ne fonctionne pas (c’est une limitation
inhérente à l’approche technique choisie). Si la remontée de score est indispensable, nous
vous conseillons de recourir à l’intégration LTI générique.

contact@ubicast.eu
https://docs.ubicast.eu/
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Vous devriez obtenir dans la vue d'ensemble des plugins ces trois plugins dans leur catégorie
respectivement Modules d’activité, blocs et Éditeur HTML Atto / Plugins Atto :

Pour le plugin Atto, vous devez avoir dans Administration du site > Plugins > Editeurs de texte
> Éditeur Atto HTML > Réglages barres Atto, cette configuration pour la barre d'outils :

​2.1.2.2.​ Ajouter un contenu en tant que ressource
Activez le mode édition, sélectionnez "Ajouter une activité ou une ressource", faites défiler
vers le bas et sélectionnez "Ressource du Nudgis" :
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Après la sélection du média, le contenu est présélectionné :
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Et sera accessible aux enseignants et aux élèves à l'aide de LTI.
​2.1.2.3.​ Ajout de contenu dans l’éditeur de texte
Si le UbiCast Nudgis atto button est installé, un nouveau bouton est visible :

Le même sélecteur s'affiche, mais avec des réglages de taille supplémentaires :
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2.1.​2.4.​ Bloc vidéos Nudgis
Le plugin UbiCast Nudgis block plugin ajoute un nouveau type de bloc qui permet d’afficher
les vidéos d’une chaîne sur le Nudgis :
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Une fois ajouté, les paramètres permettent de définir la chaîne (ou le média) à afficher :

contact@ubicast.eu
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Veuillez noter que vous devez récupérer et coller l'ID de la chaîne1

Le bloc de vidéos affichera toutes les vidéos de la chaîne sélectionnée :

1 Veuillez cliquer sur le bouton Editer de la chaîne sur le Nudgis, puis récupérer l’id via le lien du navigateur
https://lmsdemo.ubicast.tv/edit/c125cf248617ay1dkx3l/
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​2.1.2.5.​ Choisir le rôle envoyé àNudgis (plugin)
Quand Nudgis est intégré dans un cours Moodle comme un "plugin", pour choisir le rôle

envoyé, il faut aller dans : Administration du site > Utilisateurs > Permissions > Définition

des rôles.

Il faut modifier le rôle souhaité et, dans le paragraphe “Capacité”, travailler sur les lignes

suivantes:

● Par défaut c'est le rôle Etudiant qui est envoyé.

● Pour envoyer le rôle Enseignant, il faut travailler sur la ligne suivante :

Cette ligne a des conséquences sur des actions coté Moodle

(https://docs.moodle.org/400/en/Capabilities/moodle/course:manageactivities).
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Pour envoyer le rôle Admin, il faut travailler sur la ligne suivante :
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2.2. ​Blackboard
2.2.1.​ Configuration de Blackboard
Veuillez vous référer au tutoriel de configuration officiel de BlackBoard :
https://help.blackboard.com/Learn/Administrator/SaaS/Integrations/Learning_Tools_Interop
erability#addlti13

Etape 1 : Inscrire l'application

Pour ajouter l'intégration LTI de Nudgis dans Blackboard, vous devez commencer par inscrire
votre portail Nudgis dans les applications de Blackboard.
Pour ce faire, rendez vous sur https://developer.blackboard.com et cliquez sur le bouton "My
applications".

Cliquez ensuite sur "Register a REST or LTI application".
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Remplissez les informations comme dans la capture suivante.
Remplacez le domaine par celui de votre portail Nudgis et mettez la valeur que vous souhaitez
dans les champs "Application name" et "Description".

Cliquez sur "Register application".
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Conservez toutes les données de la page résultante :
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Etape 2 : Ajouter le fournisseur d'outil

Dans votre portail Blackboard, allez dans "Administrator Panel" > "LTI Tool Providers" (dans la
section "Integrations") :

Cliquez sur "Register LTI 1.3/Advantage tool" :

Mettez la valeur du champ "Application key" de l'étape 1 dans le champ "Client id" et
soumettez le formulaire.
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Dans la page résultante, définissez la valeur de "Tool status" à "Approved", cochez toutes les
cases dans "User fields to send" et définissez "Allow grade service access" à "Yes".
Conservez la valeur donnée dans la champ "Deployment ID", elle sera nécessaire dans l'étape
suivante.

Cliquez sur "submit" pour valider le nouveau fournisseur d'outil.
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Dans la liste des fournisseurs d'outil, cliquez sur la flèche à côté du nom du fournisseur d'outil
que vous venez d'ajouter puis cliquez sur "Manage placements" :

Cliquez sur le bouton "Create placement" :
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Ajouter un emplacement pour permettre aux utilisateurs d'ajouter des contenus de Nudgis.
Vous pouvez choisir d'activer ou non l'accès à l'ajout de contenus dans Blackboard avec
l'option "Allow student access".
Vous pouvez mettre n'importe quelle valeur dans le champ "Handle".
Dans le champ "Target link URI", vous pouvez ajouter "?all" à la fin de l'URL pour autoriser
l'affichage de tous les contenus lors de la sélection du contenu à intégrer par les utilisateurs.
Par défaut, seuls les contenus dont l'utilisateur est l'intervenant sont affichés.
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Etape 3 : Configurer le LMS dans Nudgis

Dans Nudgis, allez dans "Administration" > Services d'authentifications" > "LTI" et cliquez sur
"Ajouter un nouveau LMS" dans la section "Définitions des LMS (Learning Management
System)".
Remplissez les champs comme dans la capture suivante.
La valeur de l'identifiant de client provient du champ "Application id" de l'étape 1.
La valeur de l'identifiant de déploiement provient de l'étape 2.

contact@ubicast.eu
https://docs.ubicast.eu/

38

mailto:contact@ubicast.eu
https://docs.ubicast.eu/


Nudgis - Guide d'intégration LMS

2.2.2.​ Ajouter du contenu

Veuillez vous référer à la documentation officielle de Blackboard :
https://help.blackboard.com/fr-fr/Learn/Instructor/Ultra/Course_Content/Create_Content/Ad
d_Content_From_External_Sources

Dans un cours, allez dans la section "Content" et lors du survol du bouton "Build content",
cliquez sur "Nudgis content".
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Choisissez ensuite un contenu de Nudgis. Une fois le contenu choisi, il apparaîtra dans le
contenu du cours de Blackboard.
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2.3. Brightspace

2.3.1. Configuration de Brightspace

En tant qu'administrateur, allez dans "Admin tools" > "Manage Extensibility" > "LTI
Advantage".

Cliquez sur "Register Tool" :

Copiez - collez le lien d'inscription dynamique de Nudgis :

Cochez la case "Configure deployment".
Rappel : LTI doit être activé dans Nudgis et vous devez être authentifié dans Nudgis avec un
compte administrateur pour utiliser le lien d'inscription dynamique.
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Cliquez sur le bouton "Register".

Une popup va apparaître et un message de succès doit être affiché dans celle ci :

Cliquez sur le bouton pour fermer.

Le fournisseur d'outils Nudgis est désormais ajouté dans Brightspace.
Vous devez l'activer pour le rendre disponible.
Pour cela, sélectionnez l'outil et cliquez sur le bouton "Enable" à côté du bouton "Register".

Allez maintenant dans "Admin tools" > "External Learning Tools" > "LTI Advantage".
Vous devriez voir votre Nudgis dans les fournisseurs d'outils. Si le fournisseur n'est pas activé,
activez le de la même manière que précédemment.

contact@ubicast.eu
https://docs.ubicast.eu/

42

mailto:contact@ubicast.eu
https://docs.ubicast.eu/


Nudgis - Guide d'intégration LMS

Si vous envisagez d'utiliser la fonctionnalité de déplacement automatique des contenus
ouverts via LTI dans Nudgis, vous devez activer les champs liés au contexte dans les
paramètres du fournisseur d'outils.
Pour cela, cliquez sur le lien de votre Nudgis dans le tableau et cochez la case "Link
information" dans la section sécurité puis sauvegardez les modifications :
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Pour que le fournisseur d'outils soit disponible dans les cours, vous devez l'autoriser pour les
cours que vous souhaitez.
Dans les paramètres, cliquez sur "Add Org Units" :

Choisissez les cours :

Puis cliquez sur le bouton "Add".
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2.3.2. Utilisation de la page de test

Si vous avez besoin de la page de test de LTI, vous devrez aller dans le module d'un cours où le
fournisseur d'outils Nudgis est autorisé.
Cliquez sur le bouton "Exisiting activities" et sur "External learning tools" :

Cliquez sur le bouton "Create new LTI link".
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Remplissez le nom et l'URL et cliquez sur sur "Create and insert" :

Suite à cela, une activité apparaîtra dans le cours vous permettant de lancer la page de test de
Nudgis :
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2.3.3. Ajouter du contenu

Dans les modules des cours autorisés, un bouton apparait pour créer ou choisir un média de
Nudgis dans le bouton "Existing activities" :

Le nom du lien peut être changé dans la section "View links" des paramètres du fournisseur
d'outil dans Brightspace.

Une fois qu'un média est sélectionné, il apparaîtra en tant qu'activité du cours :
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Quand un utilisateur lance l'activité, il pourra accéder au média avec les permissions données
par ses rôles :
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